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1 The Basics

By The End Of This Section You Will Be Able To Identify

o Title Bar
« Ribbons
+ The Project window

o Ask a Question

The Basics

Download free ebooks at bookboon.com



Project 2010 Introduction: Part | The Basics

Guide information
Introduction

Project 2010 is a powerful application that allows you to plan, resource, manage and report on a project no matter how
large, it contains calculations, graphs. Project to web data and sharepoint information is available to be built in to the
project file so that the project can be managed across continents via the internet or intranet allowing the use of a central

pool of common resources to enable the project managers to efficiently interact and plan through project difficulties.
How To Use This Guide

This manual should be used as a point of reference following attendance of the introductory level Project 2010 training

course. It covers all the topics taught and aims to act as a support aid for any tasks carried out by the user after the course.

The manual is divided into sections, each section covering an aspect of the introductory course. The table of contents lists

the page numbers of each section and the table of figures indicates the pages containing tables and diagrams.
Objectives

Sections begin with a list of objectives each with its own check box so that you can mark oft those topics that you are

familiar with following the training.
Instructions

Those who have already used a Project file before may not need to read explanations on what each command does, but
would rather skip straight to the instructions to find out how to do it. Look out for the arrow icon which precedes a list

of instructions.
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Keyboard

Keys are referred to throughout the manual in the following way:

ENTER - Denotes the return or enter key, DELETE - denotes the Delete key and so on.
Where a command requires two keys to be pressed, the manual displays this as follows:
CTRL + [P] - this means press the letter “p” while holding down the Control key.
Commands

When a command is referred to in the manual, the following distinctions have been made:
When Ribbon commands are referred to, the manual will refer you to the Ribbon -

E.G. “Choose home from the Ribbons and then B for bold”

When dialog box options are referred to, the following style has been used for the text —
E.G.“In the Page Range section of the Print dialog, click the Current Page option”

Dialog box buttons are Emboldened - “Click OK to close the PRINT dialog and launch the print”
Notes

Within each section, any items that need further explanation or Points for extra attention devoted to them are denoted

by shading. For example:
“Project will not let you close a file that you have not already saved changes to without prompting you to save”
or

o “Project will not let you close a file that you have not already saved changes to without prompting you to

save.
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The Project screen

WINDOW BORDER The box that surrounds the Project screen when it is not maximised is called the window border.
When the mouse is over the border, the pointer changes from a single to a double-headed arrow - clicking and dragging

with this shape allows the window to be resized.

TITLE BAR The coloured bar that appears at the top of the Project window. The title bar tells you which application
you are using and if the document you are in is maximised, it will also contain the name of the document. If the Project
window is not maximised, by positioning the mouse over the title bar and clicking and dragging, you can move the Project

window to a new location on the screen.

MAXIMISE BUTTON When working in a document, the Project screen contains two windows, an application
window and a document window. You can maximise both windows to capitalise on the space you have on-screen. If you
would like the window that your Project application is in to fill up the whole screen, click the outermost maximise button.
You may find that the document you are in can still be bigger - click the inner maximise button to fill the remaining

space within the Project application window.

MINIMISE BUTTON = This button is very useful if you need to temporarily switch from Project into another
application without closing Project down completely. Click the minimise button to shrink Project to an icon on the task
bar; you will then be able to view other icons and applications you may wish to Project. When you are finished and ready
to continue, click the Project icon from the task bar to resume. The innermost minimise button will minimise the current

document window.
i

RESTORE BUTTON This button only appears when a window is maximised. A maximised window has no border
and you cannot see what is behind it. If you want to put the window back inside its border so that you can move and

size it, click the restore button.

b
CLOSE BUTTON This button is used to close a window. If you click the close button for a document window you

close the document. The last button will close the Project application.

[

DIALOG BOX LAUNCHER this button launches dialog boxes specific to the part of the ribbon you see them the
category will be named such as FONT, CLIPBOARD, etc

BACKSTAGE VIEW - FILE RIBBON is the start of Project and has many important commands and option. Such as

Project settings, opening, saving, printing and closing files. This will be looked into much further later in the manual.
Project Window Components

Project 2010 appears as displayed below when a new Project file is created.. There is a pane on the right called the Gantt
chart which displays the graphical representation of your project and on the left a table which allows you to enter the
information to build and plan your project, above these is a timeline giving you an quick view of how long your project

will run and above that you have the ribbons giving you access to all of the commands in project.
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Figure 1-1: The Project Window
» To Activate A Button On The Ribbon
Mouse

i. Click the left mouse button on the required tool.

Dialog Box
|

To open a dialog box use the DIALOG BOX LAUNCHER when the dialog box is open, make a choice from
the various options and click OK in the dialog box. If you wish to change your mind and close the dialog box without
making a choice then click on CANCEL. The dialog box will close without any choice being applied. If you would like

{313
?

help while the dialog box is open then click on the “?“ in the top right hand corner this will bring up a help window that

will display the relevant topics.
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Figure 1-2: A Dialog Box
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Groups

Look at a group type on the ribbon such as font and in the bottom right hand corner of that group you may see a small
box with an arrow, clicking this is the method to call up a dialog box as mentioned. Within the group clicking on a drop

>

down arrow will give access to a menu, any choice with three dots after it as in “more tables...” is another way of opening

a dialog box.
Toolbars

There are only two toolbars within the new version of Project 2010 there is the Quick Access toolbar seen here next to

the FILE tab, and there is the mini toolbar

| ______— | Customising
L™ R Rk menu for

\ toolbar
Task Re ~———_

Backstage View

(File Tab) ]
‘ Quick
& c Access
- Toolbar
:‘té -
|

Figure 1-3: Quick Access Toolbar
Quick Access Toolbar

By default there are only three buttons on the Quick Access toolbar but these can be edited and other regularly used
buttons can be placed there. Using the drop down menu next to the Quick Access toolbar will allow the customisation

of this toolbar adding your most often used commands.
Mini Toolbar

Whenever text is selected within Project a small formatting toolbar will appear above the highlighted text it will disappear if
the mouse cursor is moved away from the toolbar and will reappear when the mouse cursor is moved over the highlighted

text again.

Calibri 11 - g

T Rt Py
B I Dh-A-s2c5m-

Figure 1-4: Mini Toolbar
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Status Bar

The Status bar, across the bottom of the screen, displays different information at different times. To the right is an indicator,
which will display which view you are currently in and there are quick options to see which views are available and to

change the view you are in E.G. Gantt chart, resource sheet, team planner etc..

The Status bar information about the status of Project, if any particular lock keys are enabled on your keyboard, which

view is currently active, and more.

o) ¥ [ »
Ready | s Mew Tasks: Manually Scheduled | === '-E-‘ U "!"

Figure 1-5: Status Bar

Task Pane

A task pane is a window that collects commonly used actions in one place. The task pane Generally enables you to quickly
create or modify a file, perform a search, or view the clipboard the task pane is not used as much in Project as the needs
of the application are different. It is a Web-style area that you can either, dock along the right or left edge of the window

or float anywhere on the screen. It displays information, commands and controls for choosing options.

A task pane is displayed automatically when you perform certain tasks, for example when you choose Task Inspector from

the task, Ribbon, to inspect your project for problems.

m Task Resource Project Viey

=l B 5 Calibri -l -
_ﬁv

Gantt | Paste B 7 U | &~ A~
Chat~ - F = ]
View Clipboard Faont
Task Inspector x Z2
T 5
Mo task selected. E Man 17,0

Figure 1-6: Task Pane Showing Task Inspector
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Using the Quick Access toolbar

In the previous lesson, we introduced the new layout changes to Project 2010. In this section, we will learn a little bit

more about each part of the new interface and how it works. This lesson will focus on features and customization options

available with the Quick Access toolbar, located in the upper left-hand corner of the screen:

I EARAE

Gantt Eacte ! |

Figure 1-7: Quick Access Buttons
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About The Default Buttons

Access features three default commands in the Quick Access toolbar:
Save H

Saves the most recent changes to the current database file.

Undo 7 ~

The Undo command will revert most changes made in Project. For example, if you made a formatting change to a form

that you were not happy with, click the Undo button to go back one command.
Redo |:|

Sometimes you may go too far with the Undo Button this button allows you to redo what you have undone. Or redo the

last action you performed.

There is a small pull-down arrow beside the Undo button; click this to see a listing of the last few tasks that were performed.

Click any task in the list to undo all commands to that point.
Adding Buttons

As you become more familiar with Project you might find it handy to have another command quickly available for use.
Though the command tabs and ribbon significantly reduce the number of clicks it takes to do something, you might want

to have a particular command always available. Project allows you to add the command to the Quick Access toolbar.

IEEIE

Visual Reports Compare Spelling
Reports Projects

Reports | Proofing

I

F-L-LL1E

Figure 1-8: Add A Command

For example, some of us have difficulty with spelling. Fortunately, many programs (including Project) feature a spell

checking feature. In Project 2010, the spell checking feature is located in the Proofing section of the Project command tab:
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» To Add This Command To The Quick Access Toolbar,

mouse

i. Right-click the Spelling command and click ‘Add to Quick Access Toolbar:’
ii. The command (denoted by the small ABC’ icon) will be placed in the Quick Access toolbar:

 Spelling || £] e | et B S
Add to Quick Access Toolbar

_'i Maore
Customize Quick Access Toolbar...

Figure 1-9: Right Click Menu

Al d - - T s

Home _reate

Figure 1-10: Button Added

Removing Buttons

If you no longer use a certain command or your Quick Access toolbar is getting a bit too filled with icons, you can remove

them easily at any time.

?‘ = Binckbaste s WONT 2 TV

Bemove from Quick Access Toolbar

rea
Customize Quick Access Toolbar...

Place Quick Access Toolbar below the Ribbon

Figure 1-11: Right Click Remove
» To Remove A Button
mouse

i. Right-click on any icon you no longer use and click Remove from Quick Access Toolbar:
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About ribbons

One of the biggest changes in Project 2010 is the removal of menus. Instead of having a list of menu commands to choose
from (including a number of options that are greyed out and not Accessible), Project 2010 features a more intuitive control
system of tabs. Each tab contains a certain group of commands relevant only to the tab. The commands are listed in the

ribbon.

In the past, the Office package made use of menus that contained a listing of commands. At their core, the command
tabs are essentially the same thing as menus but with a few big changes. For starters, the grouping of commands in tabs
is much more intuitive. The commands listed under each tab are also the only commands that are applicable to your

current view of the Project file.

Project 2010 takes this one step further with the addition of contextual tabs. The tab labelled format is a subset of the
Gantt Chart tools and appears only when you have selected view with the Gantt chart. These tabs will contain even more

specific commands that can be used on a table being viewed and will only be visible when a table is being viewed.

2| = - = Projectl - Microsoft Project Gantt Chart Tools. = = =2

@ * can -lu - PEEmEE = Mark on Track ~ g S -, TPnspect - oy v Summary [=u] ﬁ a4 -
[ETR =2 Respect Links = 25 move ~ & Milestone P

Gantt | Paste - | B = o e Manually  Auto Task Information - | Scrall

Chart ~ - I B 7 U|&-A = | 98 | = 28 = mnacwate Schedule scnecule | [ Mode - - L Deliverable -~ & | toTask [@~

View Clipboard Font B Schedule Tasks Insert Properties Editing

Figure 1-12: Ribbon And Tabs
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Consider the Task ribbon tab that is selected in the diagram above. Beneath the tab is a listing of all commands that are

performed most often on the currently selected object, contained in what Microsoft refers to as the ‘ribbon’:

The ribbon was designed to allow access to all functionality of a tab at once. Also, the commands in the ribbon are only

the commands that are available for use at the time.
We will learn in this lesson how the ribbon works and some of the tools that are available.
Command Tabs

There are two main types of ribbons: general (or command) and contextual. The general ribbons (and corresponding

tabs) are always visible when you are viewing a Project file in Project:

Along the top of the window are the command tabs:

m Task Resource Project View Add-Ins

Figure 1-13: Command Tabs

The command tabs listed here include many of the most common commands you will perform in Project. The Task ribbon
contains the majority of the most common tasks relating to your project. to switch views, formatting, and informational

tools for the tasks..

If you want to make a new Project file, Save it or open an existing one, click the File tab and select what you wish to do.
The views tab gives you control of the many ways you may view your information in Project, Using tabs saves the need

of remembering which menu to choose.

Contextual Tabs

| il @ - - |= Projectl - Microsoft Project
Task Resource Project View Add-Ins | Format |
= _— ——
% L ul EE E S @;J Critical Tasks =
i D J]gjg.l:nlumn Settings - b Slack -«
Text Gridlines Layout = Insert i Format Base
Styles - Column ] Custom Fields - Late Tasks -
Format Columns Bar Styles

Figure 1-14: Contextual Tabs
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Contextual tabs appear only when a certain type of Project file object is selected (or brought into context). For example,

if you are looking at a Gantt chart and wish to format it or adjust it in any way then use the Gantt chart tools, format tab:

When using a command in the ribbon, simply click it with your mouse. The command will be performed, or the appropriate

tool or dialog box will appear to help you perform the task.
Further Button Options

When using many of the buttons on a Ribbon further options will be found when using the Drop down arrows (figure

1-9) say on the gridlines or Format buttons. Further options will appear.

. N
- y
Gridlines Layout Inse

v Colug

Gridlines...

&%, Progress Lines

Figure 1-15: Further Options
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The File Tab

The Basics

The File Tab (Backstage) from this you can open and close files, modify the Project program options, and close Project;

all by using the File Tab (Backstage). If you have used Project in the past, the File Tab (Backstage) is very similar in

functionality to the File menu (Project 2003) in previous versions. Or the Office menu in office 2007.

(B 9- -+

.Hu Task Resource

| save
Save As

ﬁ Open

3 Close

Recent

New

Print

Save & Send

Help
] Addns -
:] Options

B9 Exit

Projectl - Microsoft Project ‘ Gantt Cha ".1[.,.:,':‘
Project View Add-Ins Format

Information About Projectl I

i

Manage
Accounts

-

Organizer

Project Server Accounts
Not connected to Project Server

Project Information =

Organize Global Template

: . Start Date Today
Move project elements such as views, reports, and tables between two local files, o
or between a local file and the global template file. Finish Date Today
Schedule from Start
Current Date Today
Status Date Today

Project Calendar  Standard
Priority 500

Figure 1-16: The File Tab
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Let’s take a look at the commands in the File Tab (Backstage).

Save

The Basics

Saves any modifications you have made to the current database object.

Organize =

Favorite Links
E. Documents

E__J' Music
E Pictures
Public

2]
E’ Searches
i Recent Places
Bl Desktop

& Computer

Folders

# Hide Folders

File name:
Save as type: [Project (".mpp)

[P Save As el
C Y 3 —
o) | .« My Officefiles » project - | &,| ‘Segy‘f}j ol

mEn

=2 Views = B Mew Folder

Name Date modified
@hnuid.mpp
@hnu;ez.mpp
@hou;é.mpp

E]House Build2.mpp

Recently Changed

A

Type Size Tags

ODEC...

Save As

Figure 1-17: Save As Dialog

Opens the save as window and allows you to save the currently open Project under another name. This is useful if you

want to perform a major revision or update to a particular Project file. (Figure 1-23)

Open

Opens a dialog box allowing you to search your computer or network for a file.

22
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=
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. _Manuals 2010 —
| access |=|
books
excel
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| powerpoint
. project
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Figure 1-18: Open Dialog
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.H' Task Resource Project Wiew Add-Ins Format @ e B 2
I save
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Copiess 1 s
& open Print
[ Close
Info Printer
|/ Adobe PDF .
Recent =P Ready
Printer Properties
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Settings
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[ Exit A
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Page Setup

Figure 1-19: Print Options
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Clicking on the print option in backstage offers a number of options

When in Print it allows the viewing of the data in its future printed form to allow changes to be made prior to it being

printed the data will appear a little like page layout in word

Print sends any open object and its data directly to the printer. This can be a dangerous option to choose if you have not
previously seen how the data will appear in printed form as this choice will give no options for allowing changes to layout

or to where it will be printed it sends to the default printer

Printer Properties opens the print dialog to allow the choosing of a printer and various other options such as the range

of data to be printed.

Settings This section allows you to the range of data to be printed you may only want specific pages to be printed or a

certain time period

Page setup allows the page setup dialog to be opened so you can change page size margins etc.
We will look deeper into printing at various stages within the manual.

Blank Project

At the Top of the window is a link to create a new Blank Project. Use this link to make your own Project from scratch.

[ ]
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how is crucial to running a large proportion of the

world's wind turbines.

Up to 25 % of the generating costs relate to mainte-
nance. These can be reduced dramatically thanks to our
stems for on-line condition monitoring and automatic
jcation. We help make it more economical to create

Therefore we'need the best employees who can
eet this challenge!

Tﬁf Power of Knowledge Engineering

i

Plug into The Power of Knowlé ngineering.
Visit us at www.skf.com/knowledt
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» To Create New Blank Project

mouse

i. Click Blank Project to choose to create a new empty project file.

ii. Click Create to create the file.

The Basics

Add-Ins

IE“ .| | Projectl - Microsoft Project
m Resource Project View
| save
Available Templates
Save As
& Home
Lj Open
|_‘|" Close
Info 4l
Recent Blank project Recent
templates
m New from exsing
Print ' @
]
Save & Send |
Mew from Mew from
Help existing Excel
project workbook
B Addins - Office.com Templates
] Options
B mit =
]
Plans Planners

Gantt Chart Tools

Format

&

My templates

Mew from
SharePoint
task list
Search Office.com for templates
= iy
Schedules More
categories

Blank project

[

Create

Available Templates

Figure 1-20: Create New File

In the main part of the Project window are the accessible Template pane: Project has a number of templates built right into

the program. To access those click on the sample templates. The different categories of templates are from office online and

will show those templates you can download from the internet, simply click a category to see the available template files.
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Available Templates

{3 Home
I. L/.I &
Blank project Recent My templates
templates

New from existing

)

MNew from New from MNew from
existing Excel SharePoint
project werkbook task list

Figure 1-21: Available Templates

» To Create A File From A Template

mouse

i. Select my templates a dialog will open.

ii. Select a previously downloaded or created template from the available choices.

iii. Click ok to create a new file based on that template.

New =)
Personal Templates
=
Preview
To add a template to My templates, dick the
File tab, dick Save As, dick Trusted .
Templates, and then save the file as a template. Selectan icon to
see a preview,

Figure 1-22: My Templates Dialog
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Microsoft Office Online (Office.Com)

P[UJI:LL WUTEDUUK Ladsk TS0
Office.com Templates earch Office.com for templates “
-
- -
Plans Planners Schedules More
categories

Figure 1-23: Office.Com Templates

The bottom of the Project window is a special area that extracts content from Microsoft Office Online (a service provided
over the Internet). Microsoft Office Online provides quick links to different templates, training material, and other
downloads. It also provides links directly to Office Online where you can read about updates to Office 2010 as they

become available.

Recent Files

The left-hand side of the window lists any recently opened Project files, just like the Old File menu (2003) or office menu
(2007: Click one of the Project files to open the file.or click on the recent link on the left to show even more of your
recently used files. If you want to open a Project file stored somewhere else on your computer or on another network,
Using the pushpin to the right of the file will fix this files availability in the recent files list and it will not disappear when
the list fills and pushes older used files from it.

é\re you considering a \
uropean business degree? e

HANDELSH@ SKOLEN
LEARN BUSINESS at university level.
We mix cases with cutting edge
research working individually or in
teams and everyone speaks English,
Bring back valuable knowledge and
experience to boost your career,

MEET a culture of new foods, music
and traditions and a new way of
studying business in a safe, clean
environment - in the middle of
Copenhagen, Denmark.

ENGAGE in extra-curricular activities
such as case competitions, sports,
etc. — make new friends among cBs’

18,000 students from more than 80
countries.

Accredited by
Associatii
; lofMBAslon CICEMS p | 4

See what we look like

and how we work on cbs.dk
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lE“ = RN R LeEhLde =LA LGLH  House Build2. mpp [Compa
.i’ Task Resource Project View Add-Ins Format
| save
Recent Projects
@j House Build2.mpp
[ Open EnDocumentsiMy Office files\project) by
L' Close (7] housel.mpp
EM\DocumentsiMy Office files\project) by
Info
Recek
Mew

Figure 1-24: Recent Files
Closing Microsoft Project

When you have finished using Project, click either File Tab, Exit Project or - click the program’s close button in the
upper-right hand side of the Project window. If you have any unsaved work still open, Project will allow you to save any

changes you have made before the program shuts down.

Save And Send

|E|| = RN R Projectl - Microsoft Project "‘ i'r.g'».".'ﬂ[...'.'.-‘
.Hﬂ Task Resource Project View Add-Ins Format
H Save
Save & Send Send as Attachment
Save As . .
i Everyone receives separate copies of this project
5 Open =" £ E= e iEdinT i U: o Changes and feedback need to be incorporated manually
[ Close N Send as
% Sync with Tasks List Attachment
Info
" Save to SharePaint
Recent =
New File Types

Print ﬁ Save Project as File
Saveﬂ]d Create PDF/XPS Document

Help
[z Addans ~
:] Options

B Eit

Figure 1-25: Save And Send
Send As Attachment
Save and send the current project as an email attachment
Sync With Task List

Synchronise the current project with the task lists in outlook (providing you and your resources use outlook)
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Save to SharePoint
Allows the publishing to websites using SharePoint services
File Types

Save the current project as a different kind of project file many options to allow your project to be as another type of file

compatible with as many platforms as possible

Project File Types

@ Project
Save the project to the default file format.

[f=y Project 2007 Project

[LE] save the project to the Project 2007 file

format.
@ j Praject 2000-2003 Project
Save the project to the Project 2000-2003
file format.
Templates
@ Project Template (=] Project 2007 Template
i Save the project to the default template L8] Save the project to the Project 2007
format. template format.
Other File Types
XML Format (*aml)

Il €,

@ j Microsoft Excel Workbook "
HHL

|1—! Save as Another File Type
&

Save As

Figure 1-26: Different File Types
Info

This menu option gives you Three choices:

\E“ | - - Projectl - Microsoft Project Gantt Chart Tools o =
Task Resource Project View Add-Ins Format (4] (2]
| save —

s Information About Projectl \

L5 Open Project Server Accounts
= Close Iﬂ Mot connected to Project Server
Manage
Accounts
Recent Project Information ~

Organize Global Template

Start Date Today
New D Move project elements such as views, reports, and tables between two local files, N
or between a local file and the global template file. Finish Date Today
Print Organizer Schedule from Start
Current Date Today
Save & Send Status Date Today
Project Calendar  Standard
Help Priority 500
[l Addans -
:] Options
B Eit
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Project Server Accounts

When connected to project server the option allows you to manage your accounts when connected update project

information across your project infrastructure.
Organise global Template

Using the Organiser to manage your tables, forms, reports, calendars etc moving the opjects between templtes and open

files to save having to reproduce the same object many times for many files.
Project Information

Following the link on the top right allows you to modify and view characteristics specific to your Project:

SimCorp is a leading provider of software solutions for the financial industry. We work together to reach a common goal: to help our clients

succeed by providing a strong, scalable IT platform that enables growth, while mitigating risk and reducing cost. At SimCorp, we value

commitment and enable you to make the most of your ambitions and potential.

Are you among the best qualified in finance, economics, IT or mathematics?

www.simcorp.com

=
S I m CO rp MITIGATE RISK | REDUCE COST | ENABLE GROWTH
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Help

In File Tab

= - Projectl - Microsoft Project Gantt Chart Tools = @R

Task Resource Project View Add-Ins Format [~ o B E3
I save .

Support Product Activated
Save As
Microsoft Office Help Microsoft Project Professional 2010

|5 Open e Get help using Microsoft Office. This product contains Microsoft Project.
[ Close Change Product Key

Getting Started

Info Lo‘ See what's new and find resources to help About Microsoft Project
e Version: 14,0.4760.1000 (32-bit)
Recent T Additional Version and Copyright Information
M g;‘& Let us know if you need help or how we can
e make Office better. @ 2010 Microsoft Corporation. All rights reserved.
. Microsoft Customer Services and Support
B Tools for Werking With Office Product ID: 02253-001-0000205-49136
a Microsoft Software License Terms
Save & Send ptions
B Customize language, display, and other
program settings.
Hely
Check for Updates
AEEANE % Get the latest updates available for Microsoft
3 Options Office.
£ Exit

Figure 1-27: Help Options From File Tab

The Help here allows you to check on the status of the Project product and check for updates it also gives you another

point to connect with the help window as well as using the Help button.
Help Button '@

The Help button, located directly under the title bar on the far right , launches the Project help screen:

) Project Help o EBOER
(€) =) (x)(2) & &A@ R
-~ 2 Search -

41

Q Mot connected. To see additional and updated content from Office.com E]
dlick here,

| »

Project Help and How-to
What and where is the Backstage view?
Article

Get online services on Office.com
Article

mn

Read the Microsoft Software License Terms
Article

Locate the Product 1D for your Office program
Article

Get the version number for your Office program and info...
Article =

Automatically save and recover Office files
Article

Activate Microsoft Office programs
Article

= &S] |or remove your Office programs
le

pture. | | Qoﬁline J

Figure 1-28: Help Window
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o Click a topic to view help about that particular subject.
o Enter a piece of text in the search bar and search for help on that topic.
o As we explore more of the features and functionality of Project, we will discover how to use the rest of the

interface.

ToolTips

If you are unsure what a certain command does, point to it, but do not click it after a quick moment a description will

appear. This is true for most of the commands:

% & = Markon Track ~ b @ D Inspect -
S 1002 ;_\y . o \

=2 Respect Links | % Move ~
PO Manually Auto 1
=2 52 y
= Inactivate Schedule Schedule ' [ Mode ~
Schedule | Tasks

Manually Schedule (Ctrl+Shift+M)

Update the selected tasks to be
manually scheduled so that the
values you enter for Start, Finish,
and Durations are not
automatically updated.

Microsoft Project may warn you if
there are potential issues with the
values you enter.

Vowo Toucxs | Rewaur Towews | Mack Toueks | Vowo Buses | Wowo Cowsteucnion Exnesest | Vowo Pesm | Vowo Aeno | Vowo IT

Vowo Fisswcer Sepnces | Vowo 3P | Viowo Powemmeam | Vowo Paers | Vowo Tecemowosy | Wowo Loasmcs | Busieess Anes Ase

Download free ebooks at bookboon.com

32


http://bookboon.com/count/advert/fba1fd82-96d7-e011-adca-22a08ed629e5

Project 2010 Introduction: Part | The Basics

The Autocorrect feature

Microsoft Project 2010 provides the AutoCorrect feature that used to belong only to Word. AutoCorrect will assist you
in entering and editing tasks. AutoCorrect automatically corrects mistyped words and expands abbreviations as you type.
Project provides an extensive list of predefined typing corrections and abbreviations, and enables you to customize the
list by adding your own. The AutoCorrect dialog box, as shown below, allows you to type an entry (the abbreviation or

word that you want to replace) and a replacement (the text or graphic you want to use as a replacement).

AutoCorrect: English (United Kingdom) . Iilﬂ |

AutoCorrect

Correct TWo INitial CApitals
=
Capitalize first letter of sentences
Capitalize names of days
Correct accidental use of cAPS LOCK key

Replace text as you type

Replace: With:

|

(] ® -
] ® [
(m) ™

abbout about -

Add Delete

[ OK ]’ Cancel ]

Figure 1-30: The Autocorrect Dialog
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>

To Enter An Autocorrect Entry:

mouse

ii.

iil.

iv.

Vi.

From the File tab, choose options

In the options dialog choose proofing on the left and from the options on the right, choose AutoCorrect
options a dialog will appear.

Type the name of the entry in the Replace text box.

Type the name of the replacement in the With text box.

Choose Add.

Choose OK.

Do you want your Dream Job?

More customers get their dream job by using RedStarResume than
any other resume service.

RedStarResume can help you with your job application and CV.

Go to: Redstarresume.com
Use code “BOOKBOON” and save up to $15

(enter the discount code in the “Discount Code Box”)

Download free ebooks at bookboon.com


http://bookboon.com/count/advert/724b618d-009a-4836-ac75-9fb800a9d449

Project 2010 Introduction: Part | The Basics

About Smart Tags

Smart Tags, first introduced in Microsoft Office XP, make it easier for you to complete some of the most common tasks

in Project 2010 and provide you with more control over automatic features.

(1 keep Source I@rmatting
IJse Design Template Formatting

You do not have to complete any additional steps to make the Smart Tags appear or disappear in Project. The Paste
Options, AutoCorrect Options and AutoFit smart tags appear automatically to allow you to quickly choose actions and
remain in place until you begin another action. For example, when you complete a paste operation, the Paste Options

smart tag (below) remains in place alongside your text until you begin typing new text.

A “smart tag” is a type of button in Microsoft Project 2010 that appears after certain actions, such as an automatic text
correction or a copy-and-paste, have taken place. The button has a menu of options that help you control the result of
the action. For instance, if Project automatically capitalizes the first letter of a word, but you want the word lowercased in

this instance, you can click the “undo capitalization” option on the button menu to reverse the action.

Project includes several of these smart tag buttons. They function similarly but their look can vary and each has a specific

purpose.
Autocorrect Options Smart Tag ol

The AutoCorrect Options Smart Tag appears after an automatic correction or change, such as a lowercased letter that’s
changed to a capital or a network path thats converted to a hyperlink. The Smart Tag shows as a small, blue box when
you rest the mouse pointer near text that was changed; it then becomes a button icon which, when you point to it and
click it, displays a menu. If you don’t want the correction, use the options on the menu to undo it; turn off this type of

correction completely; or connect to the AutoCorrect dialog box to adjust settings.

Download free ebooks at bookboon.com

35



Project 2010 Introduction: Part | The Basics

Paste Options Smart Tag |IE T

The Paste Options Smart Tag gives you greater control and flexibility in choosing the format for a pasted item. The Smart
Tag appears just below a pasted item, such as text, a table, or a slide, with options for formatting. For example, if you
copy and paste a slide and insert it after a slide that uses a different design template, you can choose to retain the original

design for the slide or let the pasted slide assume the design of the slide it now follows.
L -
Autofit Options Smart Tag

The AutoFit Options Smart Tag appears when Project resizes text youre typing to make it fit the current placeholder. If
you don’t want the text to be resized, you can select options on the Smart Tag menu to undo the resizing or to connect to
the AutoCorrect dialog box to turn AutoFit settings off. Also, for single-column layouts, you can change to a two-column

layout, start a new slide to accommodate the text, or split the text between two slides.
Automatic Layout Options Smart Tag E

The Automatic Layout Options Smart Tag appears after you insert an item, such as a picture, diagram, chart, or table, that
changes the initial layout of the slide. To accommodate the added item, Project will automatically adjust the slide layout.

If you want, use the options to undo the automatic layout or turn it off completely.
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2 Intro to Microsoft Project

After completing this section you will be able to:

o Start Microsoft Project.

o Open a Project File.

« Change the View of a Project.
+ Use the Ribbons.

Try this... #E  options

The sequence 2.4, 6. 8,10,12, 14,16, ... 1s

the sequence of even whole ombers. The

¢
|00k place in this sequence 1S the number...°

Challenging? Not challenging? Try more »» www.alloptions.nl/life
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What is Microsoft Project?

Microsoft Project is a tool to help you to plan projects, manage and update project information, and communicate the

status once the project is under way.

The details of the project tasks and associated resources are entered into the system as a new project. The system will then
display the data in such a way that the relationships of the tasks and their time scales can clearly be seen and potential

problem areas identified.
Project data can be entered and/or viewed in a number of ways; the three principal formats are charts, forms, and sheets.

Charts

Charts can be either Gantt Charts or Network Diagram Charts both of which are a diagrammatic representation of the

project data.

Chart views: Gantt chart

Network Diagram

Resource Graph

080ct07 _ 20ct'07  [05Nov07 [19Mov07 [03Dec'07 [17Dec'07  [31Dec'07 [14Jan'0  [26Jan'08  [11Feb'08  [PSFeb'08  [10 Mar 06 [24 Mar 08 |07 Ay
06[12]16]20[24[28[01 [0s[09[13[17[21[25]28 | 03] 0v[11[15[19]23[27 31 [oaoa[12[16[20[24 |28 01[05[09[13[17]21|25]28]04[08[12[16]20 24 [28]01]05] 09|

o
I

& v

& ¢
Sid Little (architect),Peter Plank(Planner)

id Little (architect)
Planner)
E 1lPe er Plank(Planner)

12112
= "
@]Bu\\derslw]
Builders[200%]
% Builders[300%]

-

&
silders[600%],Bricks[50 Pallet (5)]
[} Chris Chippie(carpenter),Builders[200%], Timber[100 3m lengt|

|77 —Chrds Chippie(carpenter)

{7} Builders[200%]
Chris Chippie(carpenter),Builders[200%],Timber[|

=
L fH{Raul Sink (Blumber),Pipes[200 3m length (S)

@Qfddu Large(Electrician)

B

o

v
ul:Sink (Plumber),Eddie Large(Electrician)

Paul Sink (Plumber),Eddie Large(Electrician)

Paula Painter(Decorator),Paint[50 5 It tin (
Builders[200%]

Figure 2-1: Gantt Chart

Forms

Forms contain the data relevant to a single specific task or resource. These display as dialog boxes.
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Surmnmary Task Information (=3

General | predecessors | Resources | Advanced | Notes | Custom Fields |

Mame: | Build a House Duration: | 106,06 |- Estimated
Percent complete: | 0% : Priority: | 500 :
Schedule Mode: Manually Scheduled Inactive

@ Auto Scheduled
Dates

Start: | Mon 15/10/07 Finish: | Mon 03/03/08

|| Display on Timeline
|| Hide Bar
Rollup

[ OK. ] [ Cancel

Figure 2-2: A Form (Dialog)

Form views: Task form

Resource form

Sheets

Sheets are a table of all the Tasks or all the Resources that are part of the Project these appear in a spreadsheet manner.

You've applied to your University...

e Nido has some great options left! Live in one of our twin studios in
NOW Choos Nido King's Cross or two bedroom studios in Nido Spitalfields.

our Nido is the newest way of living student life in central London.
It's not just a residence, it's a way of living that we call ‘Nidology'.

Book your room and we will reward you with a £50 voucher from k]n .
www.voucherexpress.co.uk voucher* to spend in London shops! To enter, make a W‘N eVery bOO g
booking with Nido online using the promotional code ‘Bookboon01." For terms and

conditions, please visit: ®
www.NidoStudentLiving.com/Bookboon Md.o
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o Task Name - Duration Start Finish  _ |Predecessors . |Resource Names . | Add New Column
i - ~ Build a House 106.06 days | Mon 15/0/07 Mon 03
2 = Preparation 45,06 days  Mon 1510007 Wed 12M2/07
5 @ Buy Land 9.44 days Mon 1510407 Fri 261 0/07 Sid Little (architect),F
4 See architect 1469 days  Fri26/10/07  Fri16/11/07 | 3FS-5 days Sid Little (architect)
] Survey Land 519 days  Fri2810/07  Fri0211/07 3 Peter Plank(Planner}
1 Obtain Planning Permis 18.81 days|  Fri 16/11/07| Wed 1212/07 45 Peter Plank(Planner)
7 Planning perm obtainet 0 days| Wed 1212007 Wed 1212/07 &
& = Build Foundations 10.88 days Wed 1212007 Thu 27M2/07
9 Dig 4.69 days Wed 12M12/07 Wed 18M2/07 7 Builders[200%]
10 Lay Pipework 469 days| Mon 17/12/07| WMon 24/12/07 | 9FS-2 days Builders[200%]
11 0 Lay Concrete 469 days| Thu 20/12/07 Thu 27H2/07 10FS-2 days Builders[300%]
12 = Build 36 days Wed 02/01/08 Tue 19/02/03
13 Build Wallz 14.13 days | Wed 02/01/08 Tue 22/01/08 11F5+5 days Builders[500%],Brick
14 Build Roof 4 89 days | Wed 30/01/08 VWed 08/02/08 13 Chris Chippie(carpen
15 ‘Windows and Doors 5.63 days | Wed 23/01/08 Wed 30/01/08 |13 Chrig Chippie(carpen
16 Plaster 3.75days| Thu 07/02/08 Tue 12/02/08 2033+1 day Builders[200%]
17 Floor Boards 475 days Wed 13/02/08 Tue 19/02/08 16 Chris Chippie(carpen
18 = Install Services 15.94 days Wed 23/01/08 Tue 12002/08
19 Install Plumbing 5.38 days | Wed 23/01/08 Tue 05/02/08 13 Paul Sink (Plumber},F
20 Electrics 469 days| Wed 06/02/08 Tue 12/02/08 14,15 Eddie Large(Electrici
21 = Finalise 14.19 days Wed 13/02/08 Mon 03/03/03
22 Kitchen 3.81 days Wed 13/02/08 Mon 18/02/08 1920 Paul Sink (Plumber),E
23 Bathroom 281 days| Tue 19/02/08 Thu 21/02/08 1520 Paul Sink (Plumber),E
24 Decorate 469 days| Thu 21/02/03| Thu 28/02/08|22.23 Paula Painter(Decora
25 Carpets 1.88 days| Thu 28/02/08 Mon 03/03/08 24 Builders[200%]

Figure 2-3: The Task Sheet

Sheet views: Task sheet

Resource sheet

The previous views can be displayed separately or in any combination of the two e.g.

Combination view: Task Entry View
Top half Gantt chart
Bottom half Task form

You can combine any two single-pane views on the screen to create a combination view. In a combination view, the
information in the bottom relates only to the task or resources in the top view. The reason for having combination views

is to make the job of entering and analysing information easier.
Understanding Project Management

At the heart of every project management system is a scheduling algorithm. An algorithm is a mathematical or logical
equation that solves a complex problem by breaking down the problem into simple steps. When scheduling resources and
parameters are entered into it, the scheduling algorithm produces a project schedule that would be impossible for you to

produce manually. This Input/Output model is displayed below.
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Input Output
(Schedule)
Task Information
Task Name Ganit
Duration The “Black Box” PERT
Task Relationships (algorithm) Resource Graph
Fixed Costs
Constraints
Resource
Information
Who
Availability
Cost

Figure 2-4: The Input/Output Model

In Microsoft Project, however complex your project may be, you can vary only information regarding tasks or resources.

The information you provide is fed into the “Black Box” or algorithm, to provide you with a schedule in the form of a

Gantt chart, Network Diagram Chart, or Resource Graph. In summary, the seven or eight parameters that you enter result

in output that is a schedule displayed on various views and forms.

Microsoft Project Language

The project management industry uses specific language and terminology. Some of these terms are illustrated below.

Delay

EA SS

Summaz Task

—

EA The earliest possible time a task can start.
55 The scheduled start time of the fask

SE The scheduled end time of the task

LE The latest possible time a task can end.

Total Slack

Task A SE LE

L |
Predecessor Task Free Slack

Task B

—

Successor Task

Figure 2-5: Clarification Of Terms
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Non-Critical Tasks

In the illustration above, two tasks have a relationship. Task A is the predecessor task, and Task B is the successor task.
Both of these tasks are considered to be non-critical because they both have flexibility. Let’s focus on Task A. EA marks
the earliest possible time Task A can start. SS marks the scheduled start time for Task A. By default, all tasks are scheduled
to start at the earliest possible time, unless you specify otherwise. In the example above, Task A is scheduled to start later
and therefore has been delayed. SE marks the scheduled end time for Task A, and LE marks the latest possible time Task
A can end. Both of these tasks have slack. (the amount of time a task can slip before it affects another task’s dates or the
project finish date.) Free slack is the amount of time Task A can be delayed before affecting the start time of Task B, and
total slack is the amount of time that Task A can be delayed before affecting the finish date of the project.

The summary task summarizes Tasks A and B.

Critical Tasks

Critical tasks, not shown above, have no slack; therefore, delaying this type of task would mean delaying the project.
Critical Path

A critical path is a series of critical tasks. All tasks on a critical path must be completed on time for the project to finish
on time. If one task on a critical path is delayed, then the project is delayed. In Microsoft Project, a critical path is shown

on the Gantt chart and the Network Diagram Chart in red.

Fast-track

your career

Masters in Management Stand out from the crowd

Designed for graduates with less than one year of full-time postgraduate work
experience, London Business School’s Masters in Management will expand your
thinking and provide you with the foundations for a successful career in business.

The programme is developed in consultation with recruiters to provide you with
the key skills that top employers demand. Through 11 months of full-time study,
you will gain the business knowledge and capabilities to increase your career
choices and stand out from the crowd.

London Business School

Regent’s Park

London NW1 4SA

United Kingdom . . . .
Tel +44 (0)20 7000 7573 For more information visit www.london.edu/mim/

Email mim@Iondon.edu email mim@london.edu or call +44 (0)20 7000 7573

www.london.edu/mim/

Applications are now open for entry in September 2011.
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Terminology

Term

Usage

Actual Usage

A measure of the resource expended in completing or partially completing a task.

ALAP Refers to a task that should be started ‘As Late As Possible) using all the free-float
time available.

ASAP Used to indicate a task that should be started ‘As Soon As Possible] taking into
account the start date of the project and its predecessor tasks.

Baseline The original project plan, including the time schedule and resource and cost

allocations. The baseline is used for comparing projected values to actuals, and
facilitates the tracking and analysing of a project’s progress.

Cost Variance

A project tracking function recording the difference between the budgeted cost
of the work performed and the actual cost. Values below the baseline show an
overspend and positive values denote cost savings.

Critical Path

The sequence of tasks or activities whose schedules and durations directly affect
the date of overall project completion.

Earned Value

This is a measure of a project’s performance, and is calculated by multiplying a
task’s planned cost by the percentage of work completed.

Float (slack)

The amount of time by which a non-critical task can be delayed before it affects
another task’s schedule.

Gantt chart A graphical representation of a project schedule showing each task as a bar,
the length of which is proportional to its duration. Many project management
packages use a spreadsheet section to the left of the Gantt chart to display
additional information.

Hammock Task A task whose duration is calculated based on the time span between its
predecessor and successor activities.

Histogram A bar chart that shows resource workloads over a time period.

Lag The amount of time between the finish of a predecessor task and the start of a
successor task.

Lead The amount of time that a task is permitted to start before its predecessor is
finished.

Loading A measurement of resource usage on a task per unit of time. Different methods of

loading may be used depending on what’s available in your project management
application and what's applicable for your particular project.

Loading(back)

A loading pattern that allocates resource usage as late in the task as possible.

Loading (contour)

The contour-loading pattern assesses which resources are left over after allocation
to the critical tasks and spreads these resources among the remainder.

Loading(fixed)

When using fixed-loading algorithms, you specify the actual amount of resource
allocated to the encompassing tasks.

Loading(front)

Front loading systems will attempt to allocate resources as early in the task as
possible.

Loading(uniform)

This loading pattern allocates the resource usage on a by day basis in a task. This
will usually be done without causing any one task to be over committed.

Milestone

A project event that represents a checkpoint, a major accomplishment or a

measurable goal.
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Negative float Refers to an unscheduled delay before an actual task start time that must be
recovered if the project is not to be delayed.
OBS codes Organisational Breakdown Structure codes are used to identify tasks by resource

groups in a hierarchical format. OBS codes are often used to reflect departmental
structure in a company or code of accounts, and can also be used for filtering
tasks.

Network Diagram

Project Evaluation and Resource Tracking charts, also called network diagrams.
Network Diagrams are a graphical depiction of task dependencies, and resemble
flow charts. Dependencies are shown by connecting lines or arrows indicating the
work flow.

Predecessor

In dependency relationships, the predecessor is the task that must be started or
completed first.

Project Management

Best defined as a body of knowledge, a set of principles, or techniques dealing
with the planning and control of projects.

Resource

Any person, group of people, item or equipment, service or material used in
accomplishing a project task.

Resource Levelling

The process of resolving resource conflicts. Most project management programs
offer an automated resource levelling routine that delays tasks until the resources
assigned to them are available.

Resource Driven

Task durations determined by the program and based on the number of an
allocation of resources, rather than the time available. Both individual tasks and
entire projects can be resource-driven.

Sub-project

A group of activities which are treated as a single task in a master project schedule.
Subprojects are a way of working with multiple projects that keep all the data in
one file rather than in independent files.

Successor In a dependency relationship between two tasks, the successor is the task that
must await the start or completion of the other.
WBS codes Work Breakdown Structure codes are used to identify tasks in a hierarchy. Many

project management applications associate these codes with an outline structure.
WBS codes can be used to filter the project schedule for tracking and reporting
purposes.
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Starting Microsoft Project

Start Microsoft Project
» To Start Microsoft Project
mouse

i. Double-click on the Microsoft Project icon.
Or

i. Click the Start button, select Programs, select the Project icon.

ii. The Programme will start and display an empty project.

You’re full of energy
and ideas. And that’s
just what we are looking for.

© UBS 2010. All rights reserved.

Looking for a career where your ideas could really make a difference? UBS’s
Graduate Programme and internships are a chance for you to experience
for yourself what it’s like to be part of a global team that rewards your input

and believes in succeeding together.

Wherever you are in your academic career, make your future a part of ours
by visiting www.ubs.com/graduates.

www.ubs.com/graduates % UB S
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Figure 2-6: A New Project

Microsoft Project - The Screen

The Menus: Accessed by Clicking an option on the ribbon or right mouse click that
possesses a down pointing arrow next to it

Tool Bars: The Quick Access and Mini toolbars enable a speedy route to the most
common commands, The Quick Access toolbar can be customised

Timeline: Length of Project at a glance

Status Bar: At the bottom of the screen showing the current status and to change zoom
and views.

Scroll Bars: When using a mouse to scroll the views and to move the boundary between
two views.

Working Area: Sheets and Gantt Views which can be resized.
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Elements Of The Default View

The default Project view is the Gantt Chart view, (as displayed in figure 2-6). This view is used extensively in Microsoft
Project. The Gantt Chart consists of a Gantt table and a Gantt bar chart. The divider bar separates the two and can be
repositioned to display more of the table or more of the chart. The Gantt table consists of rows and columns. Just like
on a spreadsheet, the intersection of a row and a column is called a cell. The Gantt bar chart graphically displays your

schedule on a time line.

The status bar displays the current mode of operation and warning messages and indicates when special key control
modes, such as Num Lock mode, are on it Also allows you to change View and zoom in and out on your project in the
Gantt chart as already mentioned. Resizing at the join between the Gantt chart and the Table allows more columns to be

seen and worked with. But less of the Gantt obviously.

F start | ] Finish
Sl 1on 17/05/10

Wan 17/05/10

[ e Task  |Task Name - |Duration  |Start + Finish « | May'10 [17 May"10 [22 May 10 [31 May 10 [«
Mode TIw[T[F[s s [MITIW[T[F[ss [M[TIW[TTF[s[s [m[TIW[T[5

Gantt Chart

Lym| v [ VB

Ready | s New Tasks: Manually Scheduled | === —(¥)

Figure 2-7: Default Gannt View

F start | ] Finish
=l 1ian 17/05/10 Man 17/05/10

@ |Tesk - [Taskmame - |Duration  [start - |Finish  |Predecessors . |Resource Naf [0 [17 May 10 [24 May '1/a
Mode T[F[s[sM[TIw[T[F[s s [m[Tw]5]

Gantt Chart
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Figure 2-8: Resized View
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Views And Tables

A view is the format of the way that project data is displayed on the screen and there are a considerable number of different

permutations that can be used.

The Drop down arrow on the View Button on the Task tab or on the view tab is the first place where the view that is
required is selected. The basic selection is between a Chart, a Form, or a Sheet. Some of the options in this menu can

provide a split view to show two different displays for the same Task or Resource.
You can also use the View buttons, located on the bottom right of the Status Bariew Bar.

As well as the standard views achieved with the View menu or View bar, you can select More Views to see more detailed

and complex views and forms.

WORK al
Q‘L’:.IIH %
It's only an

opportunity if
you act on it

IKEA.SE/STUDENT

G007 NG SWeISAS yIN] Je] &
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Resource Sheet
Resource Usage
Task Usage
Built-In
Resource Form
Resource Graph
Task Form
Task Sheet
Team Planner
Timeline
Tracking Gantt
Reset to Default

- |
s
J Save View...
)

lore Views...

Figure 2-9: The View Menu Options

The table below describes some of the main views in Project.

Calendar:

Shows the view in the form of a calendar.

Gantt Chart:

A diagrammatic view of the Tasks and their time scale. This chart can also show the
relationship between Tasks and the Critical Path. It usually shows the task entry form
alongside the Gantt chart.

Network Diagram
Chart:

Network Diagram is an acronym for Programme Evaluation Review Technique. This
view represents each Task as a box with relevant information within it. The layout of
the boxes on the chart and the lines that link the boxes represent the structure of the
project.

Task Usage:

The Task Usage view displays project tasks with their assigned resources grouped
underneath them.

Tracking Gantt:

The Tracking Gantt view displays two task bars, one on top of the other, for each
task. The lower bar shows baseline start and finish dates, and the upper bar shows
scheduled start and finish dates (or if the task has already started, meaning that the
percentage complete is greater than zero, the upper bar shows the actual start and
finish dates).
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Resource Graph:

A graphical representation of a single resource and its utilisation.

Resource Sheet:

A list of all the resources for the project.

Resource Usage:

This is a view that shows the use in hours per day for each resource.

More Views: Allows the showing of combination views as well as details of a single Task
Table:(Entry): Changes the form alongside the Gantt chart.

Reports: Takes you into Report Wizard.

Toolbars: Allows you to change the Toolbar display.

View Bar: Activates the View bar, located vertically on the left of the screen.

Zoom: Changes the amount of information you can see on screen, from days to years.

Team Planner

A new view in 2010 which allows you to reassign work amongst team members to

more efficiently use their time.

The Tracking Gantt View

When you initially set up your project with tasks and dates, and then save the project with a baseline, the Tracking Gantt

view displays those tasks as shown in the following example.

o Task Mame Duration 15 Oct 07
SIMITIW[T]F]S]s
3 0

| Create Structure l 5 days

Figure 2-10: Tracking Gantt View

The baseline bars and the scheduled or actual bars are synchronized. However, if the start date of task slips by, say, 2 days,

the red scheduled bar will extend 2 days beyond the lower baseline bar.

Because the tasks are linked,

the slipping of task 2 will cause a ripple effect, making its successor tasks slip by 2 days as well.

You Can Use The Tracking Gantt View To:

o See how tasks progress across time and evaluate the slippage of tasks. You can track progress by comparing

baseline and scheduled or actual start and finish dates and by checking the completion percentage of each

task.

o View tasks graphically while still having Project to detailed information about the tasks.

 Create a project by entering tasks and the amount of time each task will take.

o Establish sequential dependencies between tasks by linking them. When you link tasks, you can see how a

change in the duration of one task affects the start and finish dates of other tasks and the project finish date.

o Assign personnel

and other resources to tasks.
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Microsoft Project — Ribbon tabs

The File Tab

Intro to Microsoft Project

Covered in Previous section this contains all the commands to do with the project file:

The Task Tab

The Task Tab Contains all the commands pertinent to the tasks that make up you project some of the typical commands

to be found there are:

Task Resource Project Wiew Add-Ins Format (A 0 = EX
‘:j aﬁ arial +la . ? g % g E Zl\ﬂarkon'ﬁack' S '@Insped:' 9 Summary E _J % ﬁ-
T 53 - — & A - = o e + Respect Links . _EJ Move = B 0 Milestone information 2 | seroft 2T

- ERE - @9 | 88|82 o hec dule | [ Mode - Deliverable to Task 8"
Clipboard Font Schedule Tasks Insert Properties Editing

Figure 2-11: The Task Tab
Command Function Section
Link Tasks: Create links between tasks. Schedule
Unlink Tasks: Break an existing link. Schedule
Go To: Go to a task or resource. (Depends on view.) Editing
Milestone Insert a Milestone task Insert
Tracking: Check the progress. Schedule

YOUR CHANCE
TO CHANGE
THe WORLD

Here at Ericsson we have a deep rooted belief that
the innovations we make on a daily basis can have a
profound effect on making the world a better place
for people, business and society. Join us.

In Germany we are especially looking for graduates
as Integration Engineers for

e Radio Access and IP Networks

e IMS and IPTV

We are looking forward to getting your application!
To apply and for all current job openings please visit
our web page: www.ericsson.com/careers

ericsson.
com

ERICSSON
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The Resource Tab

Intro to Microsoft Project

The Resource tab contains all the commands pertinent to working with resources such as levelling assignment of resources,

addition of resources etc

| |
Task Resource Project View Add-Ins Farmat
== = #_ @ [z Leveling Options
jﬁé‘i“s 4 Py, = % '3;
S Clear Leveling
Team Assign  Resource 5 Infarmation MNotes Details Leve Level Level .
Planner v | Resources Pool= R Resource Selection Resource Al filli Next Overallocation
View Assignments Insert Properties Level
Figure 2-12: The Resource Tab
Command Function Section
Assign Resources:

Level Resources:

Apply various filters to the tasks. Assignments

Shows resource levelling information Level

Resource Details

Show the resource form details Properties

The Project Tab

Task Resource Project View Add-Ins I Format I
= pze=! et ] Status Date: =1 = o ==
| = @) = HL = EE — = h H =5 ?
E j E—| = — = = ﬁ 180510 | = e n J ilg
Subpraoject Project  Custom Links Between WES Change Calculate Set Maove Update Visual Reports Compare | Spelling
Information  Fields Projects ~  Working Time | Project Baseline = Project Project Fro Reports Projects
Insert Properties Schedule Status Reports Proofing
Figure 2-13: The Project Tab
The main choices here are Change Working Time, project information, reports and Multiple Projects.
Command Function Section
Change Working Time: Format a new Calendar. Properties
Reports Create and run reports Reports
Links Between Projects: Set up sub projects and links. Properties
The View Tab
Eﬁ E 'ﬂ - _:'gResource Usage ~ ‘El Sort ~ B [Mo Highlight] | Timescale: 'QZoom - Timeline < | ;':IJv =
= = - @ Resource Sheet = i“j Outline * " [Mo Filter] ~ | [4] Days = ﬁ Entire Project Details = T =22
| Gantt | Task Team = ~ New Macros
Chart = |Usage » (3~ | Planner~ £ Other Views - Jt Tables - B [No Group] - &3, Selected Tasks Windeat = =
Task Views Resource Views Data Zoom Split View Window Macros

Figure 2-14: The View Tab
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The view Tab has the functionality to change views and manage aspects of your project with these new appearances.

Command

Function

Section

Team Planner

Reassign unused team resources to specific tasks new
to 2010

Resource views

overallocation of work

Timeline Add a timeline to your project to monitor how Split view
changes will affect the end date new to 2010

Timescale: Allows you to set the displayed time at anything from | Zoom
years to minutes.

Task Usage See table of tasks vs resources to monitor under or Task views

The Add Ins Tab

This Tab shows third party installed programs and Microsoft addin programs that enhance integration and functionality

of project.

EBluetooth -~

Menu Commands

Task Resource Project View Add-Ins Format

The Contextual Tabs

Figure 2-15: The Add-Ins Tab

This changes dramatically when different views are selected. The following are the principal selections.

For A Network Diagram The Choices Are:

®Bl 9~ |= ‘ng_-:,;—.ﬁ-,—._uu;;é-

Task Resource Project View Add-Ins Farmat

- = i
i {l’f oS E« Link Labels V| summary Tasks

- = — Straight Links Project Summary Task

Houl

Collapse Box Box Layout Layout Align

Boxes Styles V| Progress Marks
Display Format Show/Hide Layout

Figure 2-16: Network Diagram Tab

Command Function Section
Summary Tasks Show Summary tasks in your Diagram Show/Hide
Box Styles: Changes the appearance of the Network Diagram boxes. Format
Layout: Allows you to customise the way links are shown. Format
Layout Now: Redraws to show changes made to links etc. Layout
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For The GANTT Chart The Choices Are:

Intro to Microsoft Project

EBlE9- o= Le-lihsi e |  House Build2.mpp [Compatibility Mode] - Microsoft Project -
aliles Task Resource Project View Add-Ins Format (] 0
Afa tENE atm=2 s === s D
sTt:rets Criines Layout | e i ch::; FiEeI&;:gs Format La: ey ooal ATEEEE 201 %;l %:l gol ; 7 :LU;:;;“T::”;W“" R

Format Columns Bar Styles Gantt Chart Style = Show/Hide Drawings

Figure 2-17: The Gantt Chart Tab

Command Function Section
Text Styles: Opens a dialog used to change the font. Format
Gantt Chart Style: | Change the selected Gantt Bar style Gantt Chart Style
Outline Number: | Show The Task outline number Show/hide
Gridlines: Allows you to display or hide Gridlines and change their appearance. Format
Baseline: Change the baseline style on the Gantt Bar styles
Critical Tasks Display or hide the critical path Bar styles
Layout: Change the way the bars are displayed including links. Format
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o
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3 Planning the project

After completing this section you will be able to:

« Design a sample project.
o Begin to use Microsoft Project.

o Create a Project File.
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The stages of project management
The process of project management is divided into specific stages which can be defined as follows: -

+ Define the Project

o DPlan the project

o Implementation

« Monitoring and Adjusting

o Evaluation

Definition of the word Project: - ‘A planned undertaking’

The skills of project management are gathered from a wide range of experiences. Consciously or sub consciously we all

apply these skills in the daily administration of our work.

Where a major undertaking has to be completed, these skills are not only brought into focus but must be applied in a

much more structured format.
We must take on the jargon and techniques of the Project Manager as well as become familiar with the “Tools of the trade”

o To review the skills that are relevant to project management
o The ability to define the Goal, Objective, Specifications and Limitations of a project.
 The ability to define the individual tasks in sufficient detail and sequence to meet the objective with the

minimum of problems, and within the defined time scale.

Task attributes should include some or all of the following

o Objectives

o Time constraints

o Milestones

o Task(s) on which this Task is Dependant
o Estimated Duration: -

o Task(s) that are dependent on this task

o (Optimistic estimate)

o Itemised task Budget

o (Pessimistic estimate)

o Resources required to complete the Task.
o The ability to manage the progression of the tasks in terms of their resources, start times and finish times.

o The production of appropriate progress reports.

As the complexities of these undertakings increase so the importance of discipline and structure increase and the Project

Manager must look to the tools that can help which is where Microsoft Project comes into the picture.
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Defining The Project

Setting out the Goal and the Objectives together with the Specification and Limitations within which the undertaking

must be completed.
Plan The Project

Planning of all the activities, resources, and estimation of materials and time scales. Some of this planning may have to be
done at an appropriate level for cost estimation before the project can be agreed. Once the decision to go ahead has been
taken the skills of the Project Manager are used to define the details of the planning stage. When this has been completed

and agreed it will become the “Plan” or the base line against which progress can be measured.
Implementation

A leap into the void!

Notes: A poorly planned project will take three times longer that the original plan. A well-planned
project will only take twice as long.

A project that will be completed without changes, on time and within budget has never been
known in the past and will never happen in the future.

Microsoft Project will help!

Turning a challenge into a learning curve.
Just another day at the office for a high performer.

Accenture Boot Camp - your toughest test yet

Choose Accenture for a career where the variety of opportunities and challenges allows you to make a
difference every day. A place where you can develop your potential and grow professionally, working
alongside talented colleagues. The only place where you can learn from our unrivalled experience, while
helping our global clients achieve high performance. If this is your idea of a typical working day, then
Accenture is the place to be.

It all starts at Boot Camp. It's 48 hours packed with intellectual challenges and intense learning experience.
that will stimulate your mind and and activities designed to let you It could be your toughest test yet,
enhance your career prospects. You'll discover what it really means to be a which is exactly what will make it
spend time with other students, top high performer in business. We can't your biggest opportunity.
Accenture Consultants and special tell you everything about Boot Camp,

guests. An inspirational two days but expect a fast-paced, exhilarating Find out more and apply online.

>
Visit accenture.com/bootcamp accenture

« Consulting « Technology « Outsourcing High performance. Delivered.
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Monitoring And Adjusting
Recording Actual Progress

Once the project is under way, the progress of each activity is recorded. This information can then be compared against

the Plan and the differences highlighted.
Revising The Schedule

The process of minimising the effect of problems and delays on meeting project deadlines is achieved by adjusting and

updating the Schedule to meet the changed circumstances.
Evaluation.

As the project progresses and when it has been completed the process of evaluation should be used to learn the lessons

for the next time.
Microsoft Project - Operational Basics
Microsoft Project Has The Following Capabilities:

1 million tasks per project (depending on free RAM)
o 1 million resources per project

o Calendar dates from 1984 to 2049

Highlights

o Gantt charts to show project schedules graphically on a time scale (with scaling from minutes to years).
o Network Diagrams to show task relationships.

+ Outlining to group and arrange project tasks in hierarchical order.

« Filters to view selected information.

o Resource usage and Graph views and reports to quickly identify resource availability and costs.

« Split views to see any two screens simultaneously.

o Custom fields so you can track additional information unique to your project.
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Defining the project

Project Considerations

This is the starting point for a new project. The following are the areas that must be completed:
The Goal

This is a short statement of what the project should achieve in the broadest terms. For example if the project is to build

a new road to divert traffic away from a shopping centre the goal would be: -
To make Project to the shopping centre easier for pedestrians and improve the shopping amenities for local residents.
The Objectives

The objectives can be more specific and there can be any number of them as required. To continue the example from

above the following are examples: -

o To build a road for through traffic that does not use any existing residential areas.

« To design the road and the route to allow for the projected traffic flow for the next 20 years.
The Specification

This section will provide more detailed areas for the project, for example it may specify the broad sections of the project
and at what points approvals are required before proceeding. There may be a section concerning where resources should

come from. It may also specify the management team.
The Limitations

These are the restrictions that will affect the project, for example there may be a cost limit, there could be a set of regulations

that must be adhered to, time may be a vital factor.

When these areas are clearly specified before the project starts there is a much greater chance of the project succeeding

and major pitfalls being avoided. (In theory!)
Complete The Project Definition

As an exercise, define a project that can be planned in the next section and subsequently used in the following sections

of the manual to try out the features of the package.
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Complete The Following Form

Project Title:

(File Name)

Start Date:

Goal:

Objectives:

Specification:

Limitations:

i B ’// = l“ =)
HORIZONS UNIVERSITY

In Paris or Online
International programs taught by professors and professionals from all over the world

BBA in Global Business

MBA in International Management / International Marketing
DBA in International Business / International Management
MA in International Education

MA in Cross-Cultural Communication

MA in Foreign Languages

Innovative — Practical — Flexible — Affordable
Visit: www.HorizonsUniversity.org

Write: Admissions@horizonsuniversity.org . . .
Call: 01.42.77.20.66 www.HorizonsUniversity.org
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Project planning

This is where the experience and skill of the Project Manager must be used. At this point the project is broken down into

a series of tasks and you must ensure you have all the necessary information for each task.

The Project Manager must be confident that it will be possible to control the task as listed, if there is any doubt then the

task should be broken down into a number of smaller tasks, each of which will be easier to control.
When defining a task the following is a guide to the information required.

o The Title

« The Objective of the Task

o The time required to complete the task.

o (Give an optimistic and pessimistic estimate.)

» A note of any previous task or tasks that are associated with this task.
o The immediate subsequent tasks.

o The resource(s) that are required to complete the task.

« Any time constraints that apply.
When all the tasks have been specified together with their resources, you have completed the major part of the planning
of the project.

The next stage is to examine the flow of the tasks and the utilisation of the resources. It may well be that some of the

resources are over allocated and these problems must be resolved or noted.

At this point it will be possible to Set the Plan, this will become the base line against which progress can be

measured.
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Complete The Project Plan

Complete The Following Table

Planning the project

Number

Task Name

Duration

Predecessors

Resources
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Basic project tasks

Opening A Project
» To Open A Project File
mouse

i. Select File tab, Open to open the open dialog.
ii. Navigate to project file location and select project file

iii. Click OK to open the project file

Viewing A Project

Planning the project

There are various tools as mentioned to navigate and change the view of your project.

Brain power

Plug into The Power of Knowle ngineering.
Visit us at www.skf.com/knowled! 9

e

63

By 2020, wind could provide one-tenth of our planet’s
electricity needs. Already today, SKF's innovative know-
how is crucial to running a large proportion of the
world's wind turbines.
Up to 25 % of the generating costs relate to mainte-
nance. These can be reduced dramatically thanks to our
stems for on-line condition monitoring and automatic
jcation. We help make it more economical to create

Therefore we'need the best employees who can
eet this challenge!

Tﬁf Power of Knowledge Engineering

i
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‘EH H9-0- 5 House Build2.mpp - Microsoft Project o B =R
Task Resource Project View Add-Ins Format (A 0 = 22
E E] > _:g Resource Usage ~ ’%l Sort z [No Highlight] ~ Timescale: Q‘ Zoom ~ Timeline & 1 E:I—J' a
= E = 8 3 Resource Sheet ~ 3':| Outline ~ 7 [No Filter] - | [5] Days = ﬁ Entire Project Details = _i' S =2
Gantt | Task Team New Macros
Chart ~|Usage ~ ﬂ' Planner ~ 8 Other Views ~ _L* Tables ~ [No Group] ~ a Selected Tasks Window ..i” -
Task Views Resource Views Data Zoom “ | Split View | Window Macros
o Task Name - | Duraton Start | Finish  |Pred 080ct'07 [220ct'07 [0STwQ7 [19MNov'07 [03Dec'07 [17Dec’07 [31Dec’07 [14Jan'08 [ia
08[13] 1823280207 [ 12 2[00 [2[17[2][7 06162125
1 - Build a House 106.06 days Mon 15/10/07 Mon 03/03/08 o
& - Preparation 45,06 days Mon 15/10/07 Wed 12/12/07 o K
3 @& Buy Land 9.44 days Mon 15/10/07  Fri 26/10/07 Sid Little (architect),Peter Plank(Planner; Zoom Section
4 See architect 1469 days  Fri26/10/07  Fri16/11/07 3FS- TR id Little (architect) Controls
5 Survey Land 5.19days  Fri26/10/07  Fri02/11/07 |3 (+Peter PlanK(Planner)
6 Obtain Planning Permis 18.81days| Fri16/11/007 Wed 12120745 || | | [l Peter Plank(Planner)
7 Planning perm obtainec 0 days Wed 12/12/07 Wed 12/12/07 |6 12112
8 ‘ - Build Foundations 10.88 dayleed 12[124v| Thu 27112107
9 Dig 4.69 days Wed 12/12/07 Wed 19/12/07 7 Builders[200%]
10 Lay Pipework 469 days Mon 17/12/07 Mon 24/12/07 9FS~ Builders[200%]
1 Lay Concrete 469days Thu20/12/07 Thu 27/12/07 10FS s[300%]
12 2 = Build 36 days Wed 02/01/08 Tue 19/02/08 — Gantt and table <=
13 Buid Walls 14.13 days| Wed 02/01/08 Tue 22/01/08 11FS Resize Handle
~ I Build Roof 4.69 days Wed 30/01/08 Wed 06/02/08 13
_E 15 Windows and Doors 5.63 days Wed 23/01/08 Wed 30/01/08 /13
ig 16 Plaster 3.75days Thu 07/02/08 Tue 12/02/08 2Q3S
8 17 Floor Boards 4.75 days Wed 13/02/08 Tue 19/02/08 |1 ~~
18 - Install Services 15.94 days Wed 23/01/08 Tue 12/02/08 SCFO“ Ba rs
19 Install Plumbing 9.38 days| Wed 23/01/08 Tue 05/02/08 13
20 Electrics 4.69 days Wed 06/02/08 Tue 12/02/08 14,1y
21 = Finalise 14.19 days Wed 13/02/08 Mon 03/03/08
22 Kitchen 3.81 days| Wed 13/02/08 Mon 18/02/08 .
23 Bathroom 2.81days Tue 19/02/08 Thu 21/02/0§/19,2( Re5|ze Ha ndle
24 Decorate 469 days Thu21/02/08 Thu 28/02/£8 222!
25 Carpets 1.88 days| Thu 28/02/08 08 24
Views \ Zoom Slide
v
Ll ¥ |4 |
Ready | % New Tasks : Auto Scheduled |

Figure 3-1: View Controls
» To View Parts Of A Project
mouse

i. Press [Ctrl-Home] and [Alt-Home] to go to the start of the project.

ii. Use the scroll bars to see the project progress.

iii. Use the mouse to resize the various windows with the resize double arrow.

iv. Move the mouse to the central vertical bar on the screen when it will change to a double line with a double-
headed arrow

v. Alter the time scale with View tab, Zoom section controls or the zoom slider on the right of the status bar.

vi. Click on the Gantt Chart Button on the task tab

vii. Select a view from the list, choose each of the top five and note the different screens.

viii. Select the GanttChart view to return to the original view.
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Where to begin with Microsoft Project

The first step is to enter general information about the project in the project information box.

Starting A New Blank Project

The Project Info dialog box, illustrated below, records background information and allows you to enter scheduling

information. The dialog box allows you to specify either the project start or finish date. If you enter a start date, the finish

date will be automatically calculated. If you enter a finish date, the start date will be calculated. Note, however, that if

you choose to enter a finish date, all tasks will be considered critical because they will all be scheduled as late as possible.

If you do not enter a project start or finish date, Microsoft Project will automatically use the current date as the start date.

The Project Info dialog box also allows you to specify the project calendar, as shown below.

I Project Information for ‘Projectl’ [ﬁ‘J
Start date: Mon 15/10/07 [+] curentdate: [Man 15/10/07 =
Finish date: 07 Status date:  |[MNA [+]
Schedule from: | Project Start Date |Z| Calendar: Standard |Z|

All tasks begin as soon as possible. Priority: 500

Enterprise Custom Fields

Custom Field Name

Help | | statistis...

Value

[ OK ] | Cancel

Figure 3-2: The Project Info Dialog Box

Choosing the Statistics button opens the Project Statistics dialog box, below. This dialog box displays information on

project start and finish dates, duration, work, and cost. It also provides comparative statistics you can use to measure the

progress of your project.

Project Statistics for "Projectl’

[S5CS)

Start Finish
Current Mon 15/10/07 Fri 19/10/07
Baseline Mon 15/10/07 Fri 19/10/07
Actual Mon 15/10/07 MNA
Variance 0d 0d
Duration Work Cost

Current 5d Oh £0.00
Baseline 5d Oh £0.00
Actual 1d Oh £0.00
Remaining 4ad Oh £0.00
Percent complete:

Duration: 20% Work: 0%

Figure 3-3: The Project Statistics Dialog Box
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Project 2010 Introduction: Part |

Blank project
Available Templates
G Home
Y .: EE)
Blank project Recent Wy templates
templates
Mew from existing
)
3 !
e’
New from New from Newfro_m
existing Excel SharePpmt
project workbook task list
ffi m Templates Search Office.com for templates +
Office.co
- F
= .
] =
Create
Schedules More
Plans Planners g

Figure 3-4: Create A New Project
» To Start A New Blank Project:

mouse

i. Choose New from the File Tab,
ii. Select blank project, click create.

iii. A new project is created.

Are you consi dering a N
European business degree? i
LEARN BUSINESS at university level.

We mix cases with cutting edge
research working individually or in

MEET a culture of new foods, music
and traditions and a new way of
studying business in a safe, clean

ENGAGE in extra-curricular activities

such as case competitions, sports,
etc. — make new friends among cBs’

teams and everyone speaks English, environment - in the middle of 18,000 students from more than 80

Bring back valuable knowledge and Copenhagen, Denmark. countries.

experience to boost your career,

ZX(V@(}M(‘? b{‘ C/ C
ssociation
of MBAs EMS p. .M

See what we look like

and how we work on cbs.dk
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T e 0
Task Resource Project View Add-Ins Format o @ E =
B B oaom n - epmes T g @ Dmas gy s S S
Ba- 52 Respect Links = El Move P Milestone 2~
Gantt | Past A s Manually  Aut Task Information —- | Sroll
ot g (BT U O-A 82 e | o schedue | BMode | o (poemenie - | O™ | 0920 -
View Clipboard Font [F] Schedule Tasks Insert Properties Editing
Start Finish
Wed 15/05/10 Wed 15/05/10
@ |k - [TaskName . |Duration . [start . |10 |17 May '10 |24 May '10 |31 May '10 |07 Jun 10
Maode WITTF[s[s[M[T[WIT[F[s]s[M[TW[T[F[s]s[M[TW[T[F[s]s [m[T[w]g]
-
g m| ¥ [¥lul y
Ready | % NewTasks : Manually Scheduled EE=scs U@

Figure 3-5: A New Project

Set The Project Start Date

The first thing to do with your new blank project is to define the start date that your project will start it may be days or

months into the future

Project Information fer 'House Build2.mpp' E

Start date: w | Currentdate: Tue 18/05/10 -

Einshdate: | Mon 03/03/08 | Statusdate:  NA -

Schedule from:  Project Start Date ~ Cglendar: Heinz Project 1 -
All tasks begin as soon as possible. Priority: E

Enterprise Custom Fields

Department: |

Custom Field Name

o) [Samian)

Value

Figure 3-6: Project Start Date
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» To Set The Project Start Date

mouse

T

Task Resource Project View Add-Ins

E— = m'

@ é @] = ':'-:'5;1

U o —

Project  Custom Links Between WES Change
Information Fields Projects = Waorking Time

Properties

Figure 3-7: Project Information Button

i. In the properties group of the project ribbon select project information a dialog opens.

ii. The Project Information dialog box allows the selection of the start or end date of the Project.
iii. To view project statistics, choose Statistics.

iv. Once you have viewed the necessary information, choose Close to close the Statistics dialog.

v. Click Ok to close and set the start date of the project.

Enter Project Properties

You can enter descriptive information about your project in the Properties dialog box. This information will help you
and others identify the source and purpose of your project. The Properties dialog box consists of five tabs, described in
the table below.

Tab Function

General Provides information about the project, including project name, file type and size, file
location, dates and times of file creation, most recent modification, and most recent
Project.

Summary Provides a description of the project, including title, subject, author, company name,

manager, category, keywords, and comments.

Statistics Provides information about project use, including date created; most recent
modification, Project, and printing; person who last saved it; current revision number;
total editing time; and summary.

Contents Contains schedule information, including project start and finish dates, duration, total
work and cost, and percent complete.

Custom Allows you to enter project properties by which you can search and define links to
actual values in your project.
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Project Information ~

sl Advanced Properties

View advanced and custom
properties of this project.

: Project Statistics
ﬁ See key statistics related to
your project.

Proiect Calendar Hain> Deniact 1

rit SO0

D
r

Figure 3-8: Project Information

SimCorp is a leading provider of software solutions for the financial industry. We work together to reach a common goal: to help our clients

succeed by providing a strong, scalable IT platform that enables growth, while mitigating risk and reducing cost. At SimCorp, we value

commitment and enable you to make the most of your ambitions and potential.

Are you among the best qualified in finance, economics, IT or mathematics?

www.simcorp.com

=
S I m CO rp MITIGATE RISK | REDUCE COST | ENABLE GROWTH
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>

To Access Project Properties

mouse

ii.

iii.

iv.

vi.

Click the file tab select Info.

Planning the project

On the right side of the screen you will see the current property information for the project

Click the project Information button to expand a small menu. (figure 3-5)

Select advanced properties to open the properties dialog as discussed

From the various tabs edit or enter the information you wish.

Click ok to enter the information and close the dialog. (figure 3-6)

House Build2.mpp Properties

General | Summary | Statistics | Contents | custom |

L7 =]

Title: House Build2.mpp
Subject:
Author: Training2
Manager:

Company: |H JHeinz

Category:
Keywords:

Comments:

Hyperlink
base:

|:| Sawve preview picture

][ Cancel ]

Figure 3-9: Project Properties Dialog
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The Calendar

Planning the project

The Default Working Calendar is used by Microsoft Project to calculate all Timescales and Resource costs. It defaults to
a working day of 8 hours with the working hours 0800 to 1200 and 1300 to 1700.

r 1
Change Working Time o e s =
For calendar: |Standard {Project Calendar) |z| Create New Calendar ...
Calendar 'Standard' is a base calendar.
Legend: Click on a day to see its working times:
. October 2007 » | Working times for 15 October 2007:
g M]T|w|[Th|F[s]s
1 =z 3 4 = T8 17 «08:00 to 12:00
Monworking - « 13:00 to 17:00
Edited working 2 S (10 [11 )12 [ 13 |14
e (e 5 |17 |18 [19 |20 |21
On this calendar: Based on:
22 |23 |24 |25 |28 |27 |28
Exception day Default work week on calendar 'Standard'.
28 |30 |

MNondefault work
week

Exceptions

MName

Work Weeks

Start

Finish

Options... ] [

Figure 3-10: Project Calendar (Change Working Time)

You can create your own calendar with your own particular times. If this is not a standard 8-hour day you must remember

to tell Microsoft Project what the standard day is. Each resource you add will be based on the calendar you select when

you start your project.

Depending on the nature of your project you may find that the base calendar and standard 8-hour day is satisfactory. A

full day’s work is considered as two shifts—one in the morning and one in the afternoon. You can use the From and To

text boxes in the Working Time area to specify up to three shifts. Selecting Default restores selected days and working

hours to their default settings.

Resource calendars deal specifically with resources—that is, working hours, working days, and vacations on an individual

basis. Resource calendars are created automatically when a resource is added to the pool. Users do not create resource

calendars. It is up to the user to attach a resource to a specific base calendar.

@

Project

: i

@)

L)

Custom Links Between WES

Information Fields

Projects
Properties

-

=

D)
Change
Warking Time

Figure 3-11: Change Working Time Button
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> To Access The Change Working Time Dialog
mouse

i. Go to the properties group on the project ribbon

ii. Click the change working time button to open the change working time dialog box.(figure 3-7)

Creating A New Base Calendar

When creating a new calendar, you have the option of creating a brand new calendar or of creating one based on an

existing calendar, as indicated below

Create Mew Base Calendar u

Mame: ||3‘Il'ifﬁfShItlII |

() Create new base calendar
(@ Make a copy of |513ndard E calendar

ok ][ concel |

Figure 3-12: Creating A New Base Calendar

Vowo Toucxs | Rewaur Towews | Mack Toueks | Vowo Buses | Wowo Cowsteucnion Exnesest | Vowo Pesm | Vowo Aeno | Vowo IT

Vowo Fisswcer Sepnces | Vowo 3P | Viowo Powemmeam | Vowo Paers | Vowo Tecemowosy | Wowo Loasmcs | Busieess Anes Ase
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» To Create A New Calendar
mouse

i. Access the Change Working Time dialog

ii. Choose Create new calendar.

iii. In the Name text box, type the new calendar’s name.

iv. Select either the Create new base calendar or Make copy of calendar option button if the latter select a
calendar to copy from the drop down box choices.

v. Choose OK.

Edit A Calendar

In a calendar for the project you must define the working and non-working hours and days as these will affect the costing
and the duration of the project. Please understand if your project runs 24 hours a day your workers will only maybe
work 8 hours so a task taking a working project day will take a worker 3 days to complete increasing the cost etc. If your
project day is running for 16 hours and you have two teams working shifts (at 8 hours a day) 1 days project work will
entail the two teams working a day each. It is very important to ensure the entire project work calendar is set correctly
especially weekend or holidays where the project cannot function. You must select days, weeks or the entire calendar to

set the working hours and non-working times for the project not the workers.

Click on a day to see its working times:
Qctober 2007 «  Working times for 27 October 2007:

M|[T|w|Th|F |5 |5

...... Nonwarking R

«03:00 to 12:00

8 |9 (10|11 |12 |13 |14

"31} Edited working
------ = 15 |16 |17 |18 |19 |20 |21

On this calendar: Based on:

22123 |24 |25 |26 28
[ Exception '[Unnamed]' on calendar 'Heinz
31 Project 1'.

31 | Exception day

weel

Finish B Detais...

27/10/2007
25/10/2007 25/10/2007 [ Delete |

Figure 3-13: Adjust Project Work Times
» To Adjust Working Times
mouse

i. In the calendar, either select specific dates for which you want to make a change or select all days of the
week by selecting the column headings.(figure 3-12)

i. If required, select the desired month by clicking the up/down arrow on the vertical scroll bar of the calendar.

ii. On the tab work weeks select the default working time row and click on the details button a dialog will

open(figure 3-11)
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Details for '[Default]’ (=)

Set working time for this work week

Select day(s): _ Use Project default times for these days.
m o _1 Set days to nonworking time.

Tuesday @) Set day(s) to these specific working times:
Wednesday
Thursda

¥
Fri From To

Saturday 1
Sunday 2

Figure 3-14: Default Work Week

iii. Select the days your work week will include and change (if necessary) the working hours choose whether the
days for the selected dates will be non working times.

iv. Click ok to enter the work times.

v. Your project may run longer in the summer months and shorter during the winter months due to light,

weather or absence of staff select the start and end dates that the time periods you selected in the previous
step will run from and to.

Exceptions | Work Weeks |

Mame Start Finish -
1 |[Default] ; i

Figure 3-15: Multiple Time Periods

vi. Select another row and repeat the previous procedure for another block of time.
vii. On the exceptions tab (figure 3-10) select a row and click the details button and enter any exceptions to

the rule (for example half day holidays. Or days when the project will run longer than normal due to site
clearance etc) click ok to enter the exception.
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Details for '[Unnamed]' ==
Set working times for these exceptions
Monworking
@ Warking times:

From To

1 [ozo0 B

Recurrence pattern

9 Dally Every |1 = days
Weekly
Monithly
Yearly

Range of recurrence
Start: Sat 27/10/07 - (@ End after; 1 * occurrences
End by: Sat 27/10/07

Help | [ QK ] | Cancel

Figure 3-16: Exception Details

viii. Choose OK

Do you want your Dream Job?

More customers get their dream job by using RedStarResume than
any other resume service.

RedStarResume can help you with your job application and CV.

Go to: Redstarresume.com
Use code “BOOKBOON” and save up to $15

(enter the discount code in the “Discount Code Box”)
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Assigning A Calendar To A Project

When you first create a Project and set the start date one of the first things to do is to assign a project calendar it is
essential to do this before you start entering tasks and setting durations because if you do it afterwards then 1 project day

assigned to a task could mean a completely different thing.
» To Assign A Calendar To A Project
mouse

i. Open or create a blank project
ii. Create and edit your project calendar as previously described
iii. Open the project information dialog box from the properties group on project tab.

iv. In the Calendar drop down box select the previously created Project Calendar.

Project Information for 'Project’ &-J
Start date: Mon 15/10/07 |z| Current date: | Mon 15/10/07 |z|
Finish date: 07 Status date:  [MA [+
Schedule from: | Project Start Date E Calendar: Standard |Z|

All tasks begin as soon as possible. Priarity: 500
Enterprise Custom Fields
-
Custom Field MName Value

Help | | Statistics. .. [ 0K ] | Cancel

Figure 3-17: Assign A Calendar

v. Set the Start or end date if necessary

vi. Click Ok to finish assigning your Calendar

Download free ebooks at bookboon.com



Project 2010 Introduction: Part | Planning the project

Save the new project file
Saving A Project

While you are working on your project, make sure that you save it to disk. It is good practice to save your project every

fifteen minutes so that, if there is a power outage or power surge, you will lose only fifteen minutes of work at the most.

For a new project that you have not yet saved, you can choose either Save or Save As from the File Tab. However, the Save
As dialog box will always appear because the project does not have a name. You can give your file a name with as many

characters as you like, and Microsoft Project will automatically assign the three-character extension .MPP.

Once you have named your document, the Save command automatically saves the project under its existing filename. The

Save As command can still be used if you want to give your project a new name, leaving the original file intact.

You can also save (export) your project in formats that other programs can read. For example, you can export your project
file with an .XLS extension for use in an Excel spreadsheet, a .DBF extension for use in a FoxPro or dBase Project file, or
an .MPX extension for use in other project management applications. To export a file, in the File Save dialog box, select

the desired extension from the Save as type drop-down list, type the filename, and choose Save.
» To Save An Unnamed Project:
Mouse

i. From the File Tab (Backstage), choose Save As.
OR

ii. From the File Tab (Backstage), choose Save.
OR

iii. On the Quick Access toolbar, click the Save button.

iv. If required, select the desired drive and/or folder in the navigation areas of the window

v. If required, select a file type from the File type text box.(to save as an alternative file type or earlier version)
vi. In the File name text box, type the project (file) name.

vii. Choose Save.
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[P] Save As EXE
o

{ }U | . %« Documents ¢ My Officefiles » project v|#,| |559n;h ol
‘ Organize ~ =8¢ Views = ‘ New Folder

Eemralis Name Date modified Type Size Tags

[El Documents Blhousel.mpp

E}' Music ‘S houseZmpp

E bt @hous@.mpp

etures E]House Build2.mpp
J Public

E]House Build 2010.mpp
% Recently Changed

E Searches
5] Recent Places
Bl Desktop
More s
Folders ~
Y =M H o use Build 2010.mpp -
Save as type: [Project (*.mpp) v]
[ ODBC... J
4 Hide Folders Tools = [ Save ] [ Cancel l

Figure 3-18: Save As Dialog

Try thlS #AllOptions

The sequence 2.4, 6. 8,10,12, 14,16, ... 1s

EL\Q, SCC?UCV"-CQ O»’[ 2\en u)l/lole_ r’]um}ge,r_g‘ TLIQ,

. ¢
IOO'Hn pl@(f: la) H/rfd :;ec{uemce 1S qu, number... -

Challenging? Not challenging? Try more »» www.alloptions.nl/life
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» To Save A Named Project:
Mouse

i. From the File Tab (Backstage), choose Save.
OR

ii. On the Quick Access toolbar, click the Save button.

» To Save A Named Project As An Earlier Version:

Mouse

i. From the File Tab (Backstage), choose Save & send.

Planning the project

ii. From the displayed choices in the central window area under file types select save project as file.

iii. On the right a number of options appears select the version of project file you wish to save as.

iv. Click the save as button the save as dialog will open.
v. Enter a file name, select a location

vi. Click save to complete the save.

@ld9-o-is

\oltiae =G afes 5| House Build 2010.mpp - Microsoft Project

.HH Task Resource Project View Add-Ins Format

Save the project to the Project 2007 file

Help
[z} Addns ~
2] Options

b exit

[ save
_ Save & Send Save Project as File
£ Open @5 L Send as Attachment Project File Types
. @ Project
L3 Close s, X X Save the project to the default file format.
% Sync with Tasks List
e & j Project 2000-2003 Project
Save to SharePoint Save the project to the Project 2000-2003
Recent o file format.
- File Types Templates
@ Project Template
Print '\_E ! Save Project as File % i Save the project to the default template
format.

: Other File Types
S Create PDF/XPS Document »
- 4 j Microsoft Excel Workbook
il

1_! Save as Another File Type
(S

Save As

(== | Project 2007 Template
i Save the project to the Project 2007

s 0
© |

Figure 3-19: Save As Earlier Version
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Convert Project File To 2010 Format

If you have upgraded to 2010 to ensure the full compatibility with the new features in 2010 you must convert and update

the file to the new 2010 version.
» To Convert A File To 2010

mouse

i.  Open the project file created in an earlier version of Microsoft Project.
ii. Your file will be in compatibility mode which may not allow the saving of 2010 features.
iii. Go to the file tab save command.

iv. A dialog will open warning you which version you may be saving in click yes to convert to 2010 project file

type.

Microsoft Project =

"house 1.mpp” is & Microsoft Office Project 2003 file.
Do you want to save it in the Microsoft Project 2010 format?
« To save it, dick Yes.

« To save it in the Microsoft Office Project 2003 format, dlick Mo.

[ Yes ] [ Mo ] [ Cancel l

Figure 3-20: Convert Dialog

Ending A Project Session

At various intervals, you will need to close a project and work on other ones. Alternatively, when you are finished working

in Project, you will need to close all your projects and exit out of Project altogether.
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Closing A Project

Once you have finished working with an existing project, you will close it. When you do this, Project asks whether you

need to save the changes.
» To Close A Project:

i. From the File Tab (Backstage), choose Close.

ii. Choose Yes to save the changes.

OR

iii. Choose No to close the file without saving the changes.

Exit Project

i. Select File tab, Close to close the existing project file.
ii. Select File tab, Exit to close Microsoft project and the file that is currently open.

iii. You will be prompted to save changes to any open and unsaved project files.

You've applied to your University...

e Nido has some great options left! Live in one of our twin studios in
NOW Choos Nido King's Cross or two bedroom studios in Nido Spitalfields.

our Nido is the newest way of living student life in central London.
It's not just a residence, it's a way of living that we call ‘Nidology'.

e Voucher with

d 5 1
Book your room and we will reward you with a £50 voucher from na:
www.voucherexpress.co.uk voucher* to spend in London shops! To enter, make a W‘N eVery bOOkl g
booking with Nido online using the promotional code ‘Bookboon01." For terms and

conditions, please visit: ®
www.NidoStudentLiving.com/Bookboon Md.o
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